# Table of Contents

Table of Contents .................................................................................................................................................................................. 2

About The Web Content Management System ........................................................................................................................................... 1

Getting Started ....................................................................................................................................................................................... 1

Logging In .............................................................................................................................................................................................. 1

System Essentials .................................................................................................................................................................................. 1

  - Session Timeout ........................................................................................................................................................................ 1
  - Mobile Devices ........................................................................................................................................................................ 1
  - Auto-Save ............................................................................................................................................................................... 1
  - Assets Named “index” ............................................................................................................................................................... 1
  - Recycle Bin ............................................................................................................................................................................... 1

Dashboard ............................................................................................................................................................................................ 2

Sites .................................................................................................................................................................................................. 2

The Dashboard .................................................................................................................................................................................. 2

  - Utility Bar ............................................................................................................................................................................... 2
  - Dashboard Widgets ............................................................................................................................................................... 3
  - My Content Widget ............................................................................................................................................................... 3
  - My Upcoming Tasks ............................................................................................................................................................... 3
  - Stale Content Report ............................................................................................................................................................... 4
  - Exporting Stale Content Report ............................................................................................................................................... 4
  - Stale Content Widget ............................................................................................................................................................... 4
  - Messages/Notifications ............................................................................................................................................................. 4
  - Site Content Menu ............................................................................................................................................................... 5
  - Utility Bar ............................................................................................................................................................................... 5

Managing Content .................................................................................................................................................................................. 6

  - Context Menu ........................................................................................................................................................................ 6
  - Create a New Page ............................................................................................................................................................... 7
  - Edit an Existing Page ............................................................................................................................................................... 10

Content Editor .................................................................................................................................................................................. 11

  - Content Editor Toolbar ............................................................................................................................................................... 11
  - Paste Content ........................................................................................................................................................................ 12
  - Edit in Full Screen ............................................................................................................................................................... 12
  - Paragraph Styles ............................................................................................................................................................... 13

Saving Your Work .................................................................................................................................................................................. 13

  1. Preview Draft ........................................................................................................................................................................ 13
  2. Submit ........................................................................................................................................................................ 14
  3. Content Check ............................................................................................................................................................... 14

WCMS User Guide 2
About The Web Content Management System
The UCO Web Content Management System (WCMS), powered by Cascade Server, allows for the organization and management of website content across the university’s web presence.

Getting Started

Logging In
The University of Central Oklahoma’s Web Content Management System (WCMS) allows for the organization and management of website content across the organization.

To start using the system, you must first log in by visiting either web address below:

http://wcms.uco.edu/

Note: WCMS is not available off campus. You must be connected to the UCO network in order to access WCMS.

System Essentials

Session Timeout
If your WCMS session is inactive for 60 minutes you will be automatically logged out by the system.

Mobile Devices
Most current mobile devices and web browsers work well with WCMS.

Auto-Save
WCMS will auto-save a draft your work when you briefly pause from adding content.

Assets Named “index”
Never delete, rename or move any asset named “index.”

Recycle Bin
WCMS includes a Recycle Bin which will temporarily store deleted files. Storage is not permanent and all items will be purged after 15 days.

Assets will be permanently deleted after 15 days.
Dashboard
Once you have logged into the system, you will see the Dashboard – your WCMS control panel. From here you are able to navigate to outstanding tasks, create new content and view current activity.

Sites
Once logged in to WCMS, locate and select the appropriate WCMS site from the top right menu.

A site’s name can be typed in or selected from a list.

The Dashboard
Once you have logged into the system, you will see the Dashboard – your WCMS control panel. From here you are able to navigate to outstanding tasks and current activity.

Utility Bar
Built with functionality as the focus, the utility bar presents identifiable icons and reduces clutter by showing only the tools needed for the current task.
Dashboard Widgets

The WCMS Dashboard delivers useful content management information via widgets. The dashboard provides rapid access to data and frequent tasks. Customization is available since each widget may be relocated via drag-and-drop.

Consider adding these widgets:

My Content Widget

Head over the My Content dashboard widget for a great way to find content you have recently updated.

The widget also lists Drafts; this is a great way to locate assets that have been updated, but not submitted.

My Upcoming Tasks

Tasks may be created for yourself or for other WCMS users. This widget allows you to view, create and manage tasks.
Stale Content Report
By clicking the Stale Content tab and adding a filter for a specific web folder, you will be able to view a list of assets in need of an update. This provides easy way to see what web pages need an update.

Open the  menu by your profile and go Reports > Stale Content
Expand Filter Results, and select a timespan for Content last updated more than ___ days ago.

Exporting Stale Content Report
For more tracking updates, the Stale Content reports may be exported as an Excel-compatible .csv file.

Stale Content Widget
By clicking the Stale Content option and adding a filter for a specific web folder, you will be able to view a list of assets in need of an update.

This provides a quick overview of web pages in need of an update.

Messages/Notifications
The Messages/Notifications widget is the main vehicle for communication of system updates and status updates, it is very important that you view this section of your Dashboard each time you log in.

When a message is selected, the Notifications page will appear. This lists all messages sent by WCMS. Messages may be selected and deleted to keep the Notifications page tidy.
Site Content Menu
Sites in WCMS are organized in folders that can be easily navigated by using the site menu found by selecting **Go To A Site** on the top left of the screen.

In the Site Content menu, you are able to view folders and pages.

Navigating the Asset Tree is simple. Use the plus signs to expand folders and the minus sign to collapse folders. To view a folder or page, click on the asset name.

Utility Bar
The Utility Bar contains commands to Add Content and links to My Content and the Search utility.

My Content menu
Get an extensive overview of your recently viewed assets, drafts, tasks and more via the My Content menu, located near the search box at the top of WCMS. Recent Files and Drafts may be found here as well.
**Pop-Over Search Box & Recent Files**
Search for assets by typing the search box in the Utility Bar. A pop-up listing matching assets will appear over the page content.

**Managing Content**

**Context Menu**
To locate additional functions, right click any asset to bring up the Context Menu.

When selected the Context Menu appears and displays several commands and functions used when managing content.
Create a New Page

To create a new page, follow these steps:

1. Start by selecting the parent folder for your new page.
   a. Select Folder
2. Hover on the folder, select the ➔ arrow. This will expand and select the folder for assert placement.
3. Verify the folder is correct using the breadcrumbs at the top of the screen.

4. In the Utility Bar, select Add Content > your site > Page.

5. This will bring up the Content tab.
   a. The Parent Folder displays the location where your new page will be created. This may be changed if you did not select the correct folder.
b. To change the **Parent Folder** simply click the folder icon to bring up the **Choose A Folder** screen. Select **Recent** or **Browse** to pick a new **location** then select **Choose**.

![Choose A Folder Screen](image)

Note: new assets may only be created within folders where you have permissions to edit.

6. **Display Name** and **Title** – required for all web pages.
   a. **Display Name**: text here will **display** the Navigation bar of your website.
   b. **Title**: appears at the top of a web browser, in the breadcrumbs and in search results.
   c. **Example**: Using these settings

![Display Name and Title](image)

...information will be presented within a web browser like this:

![Web Browser Display](image)
d. The Title field will also determine how a site is displayed in search results. Careful planning and departmental consistency with the Title field of every page can greatly assist your audience in finding the information they need.

UCO: Technology Accounts and Passwords at the University of...
www.uco.edu/technology/accounts/ ▶ University of Central Oklahoma ▶
Mar 15, 2010 - Accounts and Passwords. At the University of Central Oklahoma we strive to make your experience both secure, and easy to use. Student ...

e. UCO is added automatically by WCMS to the Title field.

7. From this point, add content and images to your page using the Content Editor as shown in the following Edit an Existing Page section.
**Edit an Existing Page**

To edit an existing page, you must first select the page. This is accomplished using either of two methods:

1. Navigate through the Asset Tree and select the page you wish to edit.

2. To edit the page use one of the following methods:
   a. Hover over the name to bring up the Context Menu and select **Edit**.
   b. Select the page icon then select the **Edit** tab.

3. From this point, add content and images to your page using the Content Editor.
Content Editor

The Content Editor is where you will do most of your content creation.

Content Editor Toolbar – Editing your content with the Content Editor is very similar to editing a word document. Most of the tools are those that you will recognize from Microsoft Word; however, a few may be new to you. Note: use keyboard shortcut CTL+F to bring up Find/Replace.
**Paste Content**
If you have created content in a Microsoft Word document, or your content is already on an existing website, you can add it to your page by selecting the Paste option.

**Paste As Text**
Use **Edit > Paste as Text** to paste without any formatting and links included.

When this is selected, a notification will appear:
Paste is now in plain text mode. Contents will now be pasted as plain text until you toggle this option off.

This lets you know WCMS will continue to Paste As Text until this option is toggled off, using the same steps: **Edit > Paste as Text**. Select the X on this message to dismiss.

**Paste (with formatting)**
To paste content with links, bullets and other formatting simply use the Paste option, **Edit > Paste**.

Note: WCMS is adhering to the Chrome, Firefox and Safari security setting which does not allow web utilities to Paste via the Content Editor. As such, an error message may appear when using this method: *Your browser doesn't support direct access to the clipboard. Please use the Ctrl+X/C/V keyboard shortcuts instead.*

As a result, the content may not be pasted. Instead, use keyboard shortcuts:

To **copy** from any document or web page, select the text then use the keyboard shortcut:

Ctrl + C

To **paste**, put your cursor anywhere in the Content Editor and press:

Ctrl + V

**Edit in Full Screen** – This icon allows you to open the Content Editor in full screen mode. Simply click the icon to toggle back and forth.
Paragraph Styles

Styles are an easy way to cleanly format text via the Content Editor. To select a style for existing text, simply highlight the text and select the style from one of the dropdown boxes on the left side of the toolbar.

Alternatively, you may place your cursor on the desired line, select your style from one of the dropdown boxes.

Note: For best web accessibility, all web pages should have only one instance of Heading 1, and it should be the page Headline.

Saving Your Work

Saving and Submitting content in WCMS is a 3 step process: Preview Draft, Submit & Check Content.

1. Preview Draft

When you edit an asset, WCMS automatically saves a draft of the changes. You can preview these changes before submitting them by clicking Save & Preview.

- Drafts allow you to save a partially-updated version of an asset to be completed later without the risk of those changes being published accidentally.
- They also allow you to preview your changes on a rendered page as they’re made without having to submit a new version of the asset
- Drafts help prevent loss of data in the event of a browser or computer crash.
- All drafts are available to view in the My Content menu or dashboard widget under Drafts.

When editing an asset that is still in draft mode, a message will appear to remind you.
2. Submit
After selecting Save & preview, your changes are visible; however they remain in Draft mode. Changes are not permanent until selecting Submit.

You will be prompted to add a note about any changes made. This is beneficial should an older version of page need to be restored the notes can be referenced.

Once Check Content & Submit is selected, content will be checked for spelling, broken links and web accessibility.

3. Content Check
Spelling, broken links and accessibility checks are now part of a single process. When submitting an asset, an overview of any issues on each step will be displayed. Use the arrows to step through each item.

Spell Check
In an effort to reduce webpage spelling errors, spellcheck will be performed once asset is submitted.

Select Fix to make corrections to spelling errors. No spelling errors should should ever be on the live UCO website.

Note: For spelling, WCMS has a Global dictionary. Please send any words that should be added to support@uco.edu.
**Broken Links**

When an asset is submitted, WCMS will check that all internal links are valid. When a linked asset is not found WCMS provides an option to modify the link.

Note: Links to websites that are outside of WCMS are not checked in this process.

Corrections to broken links should always be performed to assist web visitors in locating the content they need.

![Broken Link Example](image)

**Accessibility**

For accessible web pages, all images should have alternate text (a description of the image) and each table should be tagged (described).

**Always fix these errors.** If needed, select View Non-Compliant Content to learn more.

![Accessibility Example](image)
Links, Files & Images

Web Links in WCMS

Enhance content by creating useful links for your web visitors using follow the steps below.

Creating a Web Link

1. In the editor, highlight the text or image that will become a link.

2. Next, click the Insert/Edit Link button on the toolbar.

3. A new window will appear.

4. You have two options for entering a link – external and internal.
   a) External – This is any website, document or web page that is not currently in WCMS. You can type or paste the link in the Link field, enter a Title (see Section 508 Requirements portion of this document for more details), then click Insert. Proceed to Step 8.

   **NOTE:** If you are linking to a website in the new UCO.edu design, use new.uco.edu on all link.

   An external link like this: https://www.uco.edu/academics
   **should be changed to this:** https://new.uco.edu/academics
   This will be necessary until all sites have moved to the new design.
b) **Internal** - This refers to any asset (web page, PDF, image) already present in WCMS. It could be an asset you created, an asset in another folder, or an asset used by another division or college.

5. To select an asset in WCMS:
   a. Select **Search** to open a search for specific assets.
   b. Select Recent or Browse to look for assets in other folders.
   c. Navigate to asset directly by selecting the Browse to find the asset to which you are linking.

6. Select **Choose** once you have selected an asset.

7. You will be returned to the **Insert/Edit Link** window. The link selected is now visible in the **Link** section.
8. If the destination of the link is not apparent from the text being linked, you should use the Title field. Enter text in Title to describe the link’s destination if it is not clearly stated in the content. For more information refer to the UCO Accessibility Checklist for Digital Media.

9. Using the Target drop-down menu, choose None if the link will be loaded in the same tab/window or New if it should open in a new window/tab.

10. Select click OK to complete the process.

11. Notice the text is now blue, and underlined. This is a sign that you have successfully created a web link.

Editing/Removing Links
To edit a link select the link, choose the Insert/edit link icon, make any updates needed as described in the steps above.

To remove a link, simply select the hyperlinked text or image and select the Remove Link icon.

Rules of thumb:
- Avoid use of “click here,” which when read out of context loses meaning.
- Craft text that clearly states the destination of the link eliminates the extra step of adding information in the title attribute, as shown in the example below.

To find your way around campus be sure to download a campus map here.
Files in WCMS

Uploading Files

The File Wizard allows you to upload a file (such as a PDF or an image) into the WCMS from your computer.

File names may should be lowercase, use dashes (my-file-name.pdf) instead of spaces and should not contain underscores, or special characters such as: *, [], (), !, ;, ~

Should a name not meet these requirements, WCMS will suggest a new name. Select use suggested name.

To upload a file, follow these steps:

1. Select the folder where your new file will reside in your site in the Asset Tree.
2. In the Utility Bar, select Add Content.
3. New > (Name of Your Site) > File.
4. Drag and Drop a file on the Upload screen or select Choose From your Computer to select a file to upload. (The file can be any type – pdf, doc, etc.)
5. Select Save & Preview to upload the file.
6. Multiple files may be uploaded at once. To do this continue to add files via the same method.

7. After viewing the Preview, select **Submit** to upload the file. Unless Submit is selected, the file will remain as a Draft and will not be visible in files folder.

8. Add a note to the Comments box and proceed through the Content Check.

9. The asset has now been successfully created.
Creating Links to Files or Pages

Often there is a need to link to uploaded files, such as PDF and PowerPoint files. Follow these steps to link to any uploaded file.

**Note:** You can link to ANY file or Page in the WCMS, not just those which you have uploaded.

1. In the editor, highlight the text or image that will become a link to a file.

2. Next, click the **Insert/Edit Link** button on the toolbar.

3. A new window will open.

4. **Select the Internal Box** - This will allow you to locate any asset (page, PDF, PPT, etc.) present in any folder within WCMS.

5. To select a File in WCMS, select the **Link** box with **Choose File, Page or Link**. This will open a the browse panel.
6. You may select from a list of Recent files, Browse other folders or type in a file name in Search.

7. Locate the File to which you are linking, select it and hit Choose.

8. You will be returned to the Insert/Edit Link window – notice that the File you selected is now visible in the Link section.

9. In Target, select New Window. You should always select this when linking to a file.

10. Enter a Title (see Section 508 Requirements portion of this document for more details)

11. Click OK to complete the process.
12. All done!

File Upload Limit Message
An alert will display if documents exceed the maximum file size of 10 MB.

Working With PDFs
Changing Content of a PDF without Breaking Links
With WCMS, there is no need to delete an uploaded file when needing to replace it with a revision. Any asset in WCMS can be edited or updated by making a simple upload.

The biggest benefit of this procedure is that the file name will always stay the same, resulting in fewer broken links from search engines.

To update the contents of an asset without changing the file name, follow these easy steps:

1. Locate the PDF to be updated.

2. Select the asset and then Edit.
3. Select anywhere inside the dashed box with the phrase “Drop a file here or choose one from your computer.”

4. Navigate to the asset on your computer, flash drive or network share. Select the item and **Open**.

5. After selecting the updated asset, the WCMS edit screen will return.

6. The newly selected file is ready for upload, select **Save & Preview** to preview the new asset.
7. A preview of the revised asset is now displayed. 
   Note: this item is a Draft. Submit must be selected next.

8. Enter comments about the changes made, such as what is different.
9. A message will appear asking if you would like to publish the changes.

10. Select Publish them or, if the box goes away, select the Publish icon on the asset.

11. The Publish File screen appears and displays information about publishing the asset. Expand Hide Publish Settings to display more information about the publish destination.

12. Select Publish. The updated document will be sent to the staging web server.
13. Selecting Publish will NOT put the updated asset on your live website, but will instead will allow you to preview the changes on the staging web server. (see Publishing section for more details)
Download an Asset

Any asset can be downloaded from within WCMS.

1. Select the asset then locate the ...More menu.

2. From the menu select **Download**.

3. **Save** or **Open** the asset to complete the download process.

Once you've downloaded an asset, you can edit it and upload the changed file back into WCMS.

**PDF Properties**

Before uploading a PDF, it may be worthwhile to check the Document properties to ensure all information is correct.

To do this, open the file in Adobe Acrobat pro, then go File > Properties.

On this screen you can update the Metadata for the PDF including **Title, Author, Subject and Keywords**.

Many times a PDF will be created from a Word document. As a result, the information in the Word document will be brought over into the PDF.

It is important to check and revise these fields before publishing in WCMS because this data will display in search results.
Reordering Navigation Links

Reordering assets is sometimes necessary in the WCMS if an item needs to be relocated in the side navigation.

1. To begin, select the icon next to the folder that holds the assets you want to reorder.

2. All assets in the folder are now displayed the right side of the screen.
3. Select **Order** to sort assets by their navigation position.

4. Select the **Page** or **Folder** item to be moved, and **up/down buttons** will appear.

5. Use the **arrow buttons** or **drag/drop** the item to the new order location.

6. Once finished, view any page to see the updated navigation.

**Note:** Once navigation has been changed, it is important to republish your entire site to the live UCO website.
Adding New Navigation Items

New Items Default to Last Position
When a new page or folder is created, it will be automatically added as the last item in Navigation.

Use the steps outlined in Reordering Navigation Links if items need to be moved up or down.

Folders in Navigation
Folders are a great way to group pages related to a specific topic, such as Forms or Training.

For a folder to appear in Navigation you must A) create a folder, and B) have an asset inside named index.

A: Create a Folder
1. Begin by selecting the site where you want the new folder to reside. Folders may also be added within other folders – these are called sub-folders.

2. Select the Add Content button then choose Folder.

3. The first item in the Create Folder box is the Placement Folder – this is the location where the folder will be created. To change, select the folder icon.

4. Enter the Display Name and Title. Note that Display Name determines the words shown in navigation.
5. Set folder display option for **Navigation** – generally these can be left as the default.

   a. **Settings:**
      
      i. **Start Navigation Here**, when set to **YES**, will include the navigation from above.
      
      ii. **Start Navigation Here**, when set to **No**, will begin the navigation at this folder’s level.
      
      iii. **Start Subsite** Here is not used and does not impact display of navigation.
      
      iv. **Include in Side Navigation** should be set to **Yes**.

6. Select **Submit** to complete the process.

---

**B: Create an Asset with System Name index**

For folders to display in navigation, **folders must have an asset with a system name of index** (lowercase).

1. Select the new folder which was just created. When selected the folder will be highlighted.

2. Make a new page in this folder as detailed in **Create A New Page**.

3. Once created, select ...**More** menu and choose **Rename**.

4. The **Rename Page** window opens.
5. Delete any words in the **New Page Name box** and replace them by typing the name: **index** (this **MUST** be in lowercase).

   ![Renaming page](image)

6. The new folder will now show in the Navigation.

   ![Navigation](image)

7. As with pages, when a new folder is created, it will be automatically added as the last item in Navigation. Use the steps outlined in **Reordering Navigation Links** when items need to be relocated in the navigation menu.
Images in WCMS

Image Dimensions
When uploading images, it is important to follow the following rules for dimensions. Be consistent with image sizes, determine the best size for your site and make that the standard for all pages.

**Recommended sizes for images in the main content area:**

**Thin Navigation:**
- Width: 692 px (max)

**Thick Navigation:**
- Width: 625 px (max)

**Expanding Navigation:**
- Width: 620 px (max)
Uploading an Image

The WCMS allows for a maximum image file size of .5 megabytes.

To upload an image, follow these steps:

1. In the Menu Bar, select Add Content then New > your site > Image.
2. Drag and drop a file or select Choose Some From Your Computer.
3. The selected file will be viewable on-screen.
4. Images may be resized using the width & height buttons. Additional editing tools are available.
5. Edit if necessary (see next page).
6. Select the Save & Preview button.
7. The image preview will be presented.
8. Select Submit to complete the upload process.

Image File Size

WCMS allows for a maximum image file size of 1/2 megabyte. Images larger in size will produce an error.
Adding Images to Content with the Insert/Edit Image Tool

Once the image has been uploaded, add it to your page content with these steps. Place the mouse cursor in the content area where the images will be added.

1. Click the **Insert/Edit Image** icon.

2. Select Image > Choose File, then locate an image.

3. To browse Thumbnails, select the thumbnails icon.

4. Pick an image and select **Choose**.

5. Set the Image Properties.

- **Alternate Text** – This text will appear when a cursor rolls over an image. This is necessary for ADA, section 508 compliance. Always complete the Alternate image text.
- **Width/Height** – Dimensions, in pixels, of the image used. This can be adjusted by entering a new size.
- **Class** can be left empty.
Image Properties: Advanced tab

*Vertical & Horizontal Spacing*
There may be times you would like more space between an image and the text surrounding it. In the image below, the image is right next to the text. This is also known as “padding.”

**Before Spacing**

**After Spacing**

Add Spacing Between Images and Text
1. Select the image, then right click or choose the **Insert/Update Image** button.
2. In the **Vertical Spacing** box, enter a number ranging from 5 to 10 pixels. Repeat the process for **Horizontal Spacing**.
3. Select the **OK** button to see the changes.
Image Properties:

**ALT Attribute for Images**

**Basic Images**
If an image is a drawing or a photographic picture, make sure that the alternate text adequately describes the content of the picture in 50 characters or less.

![Image Properties](image.png)

**Image Alignment**

Once an image is placed in the content area, it may not be aligned properly. Utilize the paragraph Left or Right justification buttons to find the right position.

![Image Alignment](image.png)

**Images containing text**
When an image contains text, make the alternate text correspond to the image’s text.

Don’t add additional text such as “logo”, “image”, “photo”, etc.
Adding Videos

The Content Editor allows for easy embedding of media on any page.

When the new window pops-up, just paste in the link to YouTube (or any video sharing website) and click Insert.

1. Click Insert/edit embedded media button.

2. Paste the Link to the video.

3. Select OK.

4. The video preview will show in the content editor.
System Tools

Avoid Delete, Move or Renaming of files

When working on an asset that seems to be in the wrong location, or has a system name that needs to be changed or deleted, please contact Service Desk (support@uco.edu) to request assistance before moving, renaming or deleting any WCMS items.

Failure to do so may result in old files remaining on www.uco.edu. All assets must first be un-published so they are it be completely removed.

Following this procedure will ensure that outdated pages and documents are not displayed when web visitors are searching uco.edu.

Note: There may be a slight delay in search web sites like Google in catching up with the change. Please allow a few days for such sites to update their links.

Checking Relationships & Deleting an Asset in WCMS

This procedure works for any item (pages, images, documents, etc.).

1. Locate the asset to delete.
2. Select ...More > Relationships menu item.
3. This will list all the other assets using or linking to the asset you plan to delete. If no items display, proceed to Step 3.

   a. All assets listed must be edited to remove references to the asset you will be deleting. Skipping this step will result in “page not found” for website visitors.
   b. In the event you are unable to edit assets referencing the item to be deleted, use the Last Modified column to identify the content owners to contact.
   c. Proceed only when ZERO items display on the Relationships tab.

4. Request an unpublish.
   a. Send an email to support@uco.edu and specify which asset(s) should be unpublished.
   b. A Service Desk ticket will be created and a technician will unpublish the specified asset(s) from the production server.
   c. Once the ticket is closed, you will be notified and should then delete the asset in WCMS.

5. The Delete function is located in the ...More menu item.
6. On the delete confirmation page, the **Content Links** section will display if any content is still referencing the asset. No items should be linking to a page that will be deleted.

![Delete page](image)

7. Work to resolve any content references with the content owners.
8. Continue to click Delete until no items are listed.
9. Once the Content Links section no longer appears, select **Delete** to perform the Delete.

![Delete page](image)

10. When Delete Successful displays the asset will have been removed and is now located in the Recycle Bin.

![Delete successful](image)

11. Be sure to request a site republish if this change will impact your navigation.
Restoring Deleted Assets

1. Locate the Trash icon below Site Content menu.

2. Select an asset then select the Restore arrow icon to restore.

3. Confirm that you wish to restore the asset by selecting Submit.

4. Restore Successful will display and the asset will be put back in its original location.

   Note: Once restored, the asset must be published before it will be visible on the UCO website.

Live View

The menu item ...More > Live View is a handy feature for previewing the published version of a Page. This is useful for:

- Checking to see if the content has been updated.
- Finding the published URL of the Page
- Previewing the page with server side scripting enabled

When Live is selected the same page (if published) will open in a new tab/window.
Publishing

Publish a Page or Folder for Preview
Changes made to your web page may be viewed on the WCMS Preview site. This is an exact representation of what your web pages will look like on the UCO website.

You must be on the UCO network to view the Preview website.

The advantage to Preview is that you can make as many changes as needed, and preview them, before your website goes “live.” To see your published page or site, visit this link:

**WCMS Production Servers**

<table>
<thead>
<tr>
<th>URL</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://sites-staging.uco.edu/">http://sites-staging.uco.edu/</a></td>
<td><a href="http://sites-staging.uco.edu/academic-affairs">http://sites-staging.uco.edu/academic-affairs</a></td>
</tr>
<tr>
<td><a href="http://acm-staging.uco.edu">http://acm-staging.uco.edu</a></td>
<td></td>
</tr>
<tr>
<td><a href="http://alwayscentral-staging.uco.edu">http://alwayscentral-staging.uco.edu</a></td>
<td></td>
</tr>
<tr>
<td><a href="http://careers-staging.uco.edu">http://careers-staging.uco.edu</a></td>
<td></td>
</tr>
<tr>
<td><a href="http://ce-staging.uco.edu">http://ce-staging.uco.edu</a></td>
<td></td>
</tr>
<tr>
<td><a href="http://chkcentralboathouse-staging.uco.edu">http://chkcentralboathouse-staging.uco.edu</a></td>
<td></td>
</tr>
<tr>
<td><a href="http://endeavorgames-staging.uco.edu">http://endeavorgames-staging.uco.edu</a></td>
<td></td>
</tr>
<tr>
<td><a href="http://events-staging.uco.edu">http://events-staging.uco.edu</a></td>
<td></td>
</tr>
<tr>
<td><a href="http://faculty-staging.uco.edu">http://faculty-staging.uco.edu</a></td>
<td></td>
</tr>
<tr>
<td><a href="http://faculty-resources-staging.uco.edu">http://faculty-resources-staging.uco.edu</a></td>
<td></td>
</tr>
<tr>
<td><a href="http://ucojazzlab-staging.uco.edu">http://ucojazzlab-staging.uco.edu</a></td>
<td></td>
</tr>
<tr>
<td><a href="http://oga-staging.uco.edu">http://oga-staging.uco.edu</a></td>
<td></td>
</tr>
<tr>
<td><a href="http://okjournalism-staging.uco.edu">http://okjournalism-staging.uco.edu</a></td>
<td></td>
</tr>
<tr>
<td><a href="http://students-staging.uco.edu">http://students-staging.uco.edu</a></td>
<td></td>
</tr>
<tr>
<td><a href="http://ucodowntown-staging.uco.edu">http://ucodowntown-staging.uco.edu</a></td>
<td></td>
</tr>
</tbody>
</table>

No page edits or site navigation changes will be visible on [www.uco.edu](http://www.uco.edu) until after being published to a Production Server.
Publishing Your Website to Preview/Staging

Publishing Pages

1. To publish a page to the Preview web server, locate the page, and click the Publish icon.

2. Locate and select Publish to complete the process.

3. WCMS will display two confirmation messages, first that the process has started, and a second that the request has been completed.

4. Visit the page and verify all items are correct on the Staging server: http://sites-staging.uco.edu/YourDepartment/yourPage
Publishing Folders

There may be situations where an entire website, and all pages and folders which need to be published.

1. In the Asset Tree, select the Folder you wish to publish.

2. Select the Publish icon.

3. On the Publish window, verify the Staging Server is the only item selected, then select Publish.

4. A message will confirm that the publish process has started.

5. A second message will display stating the publish is complete, usually confirming that 0 issues occurred.

6. Visit the folder and verify all items are correct on the Staging website: http://sites-staging.uco.edu/YourDepartment/yourFolder
Procedure to Publish a Page or Folder to Production (Live UCO website)

“Publishing to Production,” “publish live” or “going live” are all terms used to indicate that a website or web page is ready to be visible to the world. When your website is complete and ready for publishing “live,” follow these steps.

1. Send an email to the UCO Service Desk: support@uco.edu
2. In the subject line, enter WCMS: Publish (name of your site or page)
   **example:** WCMS Publish: University Relations website
3. In the body of the email, include the web link to your site or webpage.
   **example:** Please publish our website to production: www.uco.edu/technology
4. Send the email message.

You will receive a response from UCO Service Desk when your request has been completed.

Additional Resources

Page, Folder and File Names

When uploading documents always use lowercase and always replace spaces with dashes.

Rules of Thumb when naming a page:
NO CAPS, NO_UNDERSCORES_, (NO)$_Y^^BOLS*

- Correct: my-page-name
- Incorrect: My Page Name

If a file does not meet this criteria, WCMS will show an alert.

The alert will suggest a new file name that fits the requirements.

When this happens, it is recommended to select **Use The Suggested Name** before proceeding.
Assistance & Support

**UCO Service Desk**

Phone: 974.2255 (CALL)
Email: support@uco.edu
Location: Max Chambers Library 1st Floor

[http://servicedesk.uco.edu](http://servicedesk.uco.edu)

**Technology Resource Center**

Phone: 974.5595
Location: ADM 101

[http://trc.uco.edu](http://trc.uco.edu)

**Office of Information Technology**

Phone: 974.2688
Location: ADM 102

[http://technology.uco.edu](http://technology.uco.edu)